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The Inside Poop

Red Ryder Version 8.0.  Whew!  I guess I knew that I couldn't hang on to the $40 price tag forever.  Now with the addition 
of Red Ryder Host to this product (which fills an entire disk of its own), I'm afraid it's time to face the realities of the world 
and jack up the price.  It's now $40.

Though I am at the epicenter of this project, when I take a step back from the screen and scratch my noggin a bit I 
realize that very little of Red Ryder is my own creation.   It would be more philosophically accurate to call me the chairperson 
rather than the author of Red Ryder.  Many of you will see things in this version that you'll immediately know exist because 
of your participation.  I hope you'll feel as much a part of this project as I do.

Don't let this documentation fool you.  Red Ryder is indeed a complex program (since it deals with an entity that has so 
many variables), but it is intuitive enough to feel comfortable with the major and most frequently used functions after only an 
hour or so.  If you're like me, you hate to read documentation - so go ahead and experiment!  Most of the bread and butter 
functions can be mastered without touching this manual.  My advice is to read the bulk of this documentation in the 
bathroom, when you've got some free time and want to learn about the many powerful features that are there waiting for you 
when you're ready.  Red Ryder was not written in a day, and you won't master it in a day.  It is easy enough to begin working 
with immediately, but it has features powerful enough to continually challenge your creative genious as you gain experience. 
Do read the chapters sequentially - if only in browsing.  When something goes a bit over your head, back up and make sure 
you understand everything up to that point before progressing.

Some of you may have procured a copy of this program thinking it is free or public domain software.  It is neither.  It's 
user-supported software and if you use it that means both a legal license and a contract of honor exists between you and I.  
I have poured my soul (and most of my assets) into this package, and have released it in this manner to provide you with an 
alternative to this industry's bad habit of jacked-up prices, unreasonable evaluation and upgrade policies, and copy 
protection.  It's my way of giving them the finger, if you follow me.

You will quickly find that this program is an anomaly in more than the obvious way.  It is not only updated, but upgraded 
so frequently that it's more like an ever-lasting subscription than a one-time purchase.  It's one of the few programs where 
your opinion is more important than the author's, and one of even fewer where you have such direct access to the author 
when you need technical support or want to influence future versions.

This program was written on a single 512K Macintosh with a 400K external disk drive, using the Aztec C compiler and 
Assembler from Manx Software Systems.  Not only did I place myself into debt to produce this program, I will depend on its 
proceeds to put food on my table.  Those of you who would steal from me by using this program and not registering should 
know that you are stealing from an individual who relies on this product as his sole source of income.

If we are to pave the way for more and better software distributed in this manner, we've got to take the responsibility to 
buck up when the product's good.  We cannot allow thieves to give software authors, including myself, no other option than 
copy protection and high prices.  
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Parables usually give me a rash, but the following one really struck home.

"After conquering a local tyrant, a village decided to put on a big shindig to celebrate their new freedom.  Every villager 
agreed to bring two skins of their best wine, which would all be poured into a great vat to symbolize the unity with which they 
fought.  One villager (every village has at least one) was the stingy sort who decided he would put water in his skins instead 
of wine, calculating that the dilution would go unnoticed.  He made sure no one discovered his plot as the entire village 
stood in line, emptying their skins of wine into the vat.

Finally came the evening of the great shindig.  As the villagers gathered with their tankards around the vat, the newly 
appointed leader gave a speech that inspired one and all.  Finally, the villagers suggested that the leader be first to fill his 
tankard from the vat, and the leader happily agreed.

When the leader placed his tankard under the vat and turned forth the flow of wine, he was surprised to find that his 
glass was filled with clear water."
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You are hereby licensed to use and distribute this product under the following conditions:

1) You can give a copy of this program and the documentation to anyone you like after April 3, 1986.  You may 
not sell it or receive monetary compensation for distributing it.   Forbidden are such charges as duplication or materials fees. 
It must be given away absolutely at no charge.  You may not distribute it along with a product you sell without my written 
permission. You must not modify the program or documentation in any way.  If you give out a copy of the program, you must 
give the full documentation files with it.  You must tell the person that you are giving it to that this is a user-supported 
package, and instill in them the spirit of what that means.  In short, if you try to profit from my work other than through 
its use, it's a violation of my copyright which I must enforce to legally retain.  I have filed Federal Form SE with the United 
States Copyright Office, and would just love to find someone who has the gall to violate this civilized license.  Do both you 
and I a favor and don't get on the wrong end of my ugly lawyer.  Use the program and enjoy it.

2) Evaluate the program on your own terms, at your own pace, and on your own machine. If you decide it's not 
suitable for your purposes after 45 days of the date you received it, you must either erase it from your disk(s) or (better) give 
all copies to someone else.  I update this product quite frequently (6 times in the last 12 months) so that registered users 
always have a much better product than the thieves.

If you supply your friends with updates so they don't need to register, you'll dilute the main benefit of registration and 
cause me to update Red Ryder less frequently, if at all. 

3) If you find it useful, you must register your copy by sending $40 ($45 in U.S. funds for foreign customers) to The 
FreeSoft Company, 10828 Lacklink, St. Louis, MO 63114 within 45 days of receiving it.  You're also honor bound to send us 
a few comments, criticisms, suggestions for improvement, or "atta boys" when you register.

4) For a list of what you get for your registration fee, please read the "Registration Benefits" chapter at the end of this 
manual.

5) If you as users do your part and support us, we are honor bound to continue to improve this product, and release 
more of the same quality.  We have many projects underway that I know will make your Mac earn its keep.  The only way 
they'll ever see the light of day is to continue to convince us that user-supported software is a valid marketing method.

6) Each registration is for a single individual only.  Each registered copy may be used on only one computer at a 
time.  Corporations, schools, user groups, or other entities that wish to register more than one copy should contact us at the 
address on page 1.  You'll find us more than reasonable to work with for such things as quantity discounts.

7) I won't insult you with a "tough-luck" license.  If you are a registered user and you find a program error (something 
that doesn't work as it's documented), The FreeSoft Company will either fix it or return your registration money, at your 
option.  By using Red Ryder, you do agree to limit The FreeSoft Company's and the author's liability for any calamities to 
your registration fee.  You are obviously free to make as many backup copies as you like, and you can sell your registration 
to someone else so long as you give them all copies of the program and documentation you own and notify The FreeSoft 
Company of the transfer of registration.

8)  A non-profit organization can get special permission from me to recover the cost of materials and duplication by 
inquiring.  Until you receive written permission signed by my hand, you may not charge for copies of Red Ryder.  
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Background Information For Beginners

A modem is a device that works with a computer in the same manner as a telephone handset works with your head.  
Both of these translate the original communications media (for humans: sound, for computers, digital electronic signals) into 
the ephemeral bleeps and blorps that the telephone lines are capable of carrying.  The receiving handset or modem then 
retranslates the bleeps and blorps back into voice or electronic signals.

Consider a telephone conversation between people.  Both persons must (either implicitly or literally) agree to speak in a 
language both participants understand, and a certain degree of etiquette (or protocol) must be followed throughout the 
conversation (such as not hollering wildly at the same time).  Using computers and modems is very much the same.

The first thing you must know before calling another computer is what language it expects you to use.  For computers, 
we refer to this language as the communications protocol.  If you set up your computer to use a different protocol than the 
computer you call uses, you'll either get "garbage" characters on your screen or nothing at all.  Sooner or later, one of you 
will get frustrated and hang up.

Communications protocol can be divided into several components.  We call each component a parameter.  Each 
parameter must be set up correctly to communicate properly.

Baud Rate - this is how quickly the computers are capable of "speaking" to each other.  The choices Red Ryder offers 
are 300, 450, 1200, 2400, 4800, and 9600 baud.

Parity - This is a simple form of error checking.  Red Ryder supports NO Parity, EVEN Parity, ODD Parity, MARK Parity, 
and SPACE Parity.

Data Bits - This size of each character.  Red supports 7 data bits and 8 data bits.

Stop Bits - Additional signals sent at the end of each character transmitted.  Red supports 1 stop bit and 2 stop bits.

Duplex - This is the "etiquette" we spoke about earlier.  Red supports HALF Duplex, FULL Duplex, and ECHO Duplex.  
HALF Duplex is what some users refer to as "local echo", and should not be confused with ECHO Duplex.  ECHO Duplex 
will never be used by both callers at the same time, and is only used by Red Ryder when it is acting in a host capacity (see 
the chapter on the Host Mode for more details).

You'll need to contact the operators of the computer you'll be calling (or consult the documentation that describes the 
service) to find out how to set up these parameters.  There will be times, however, that this is not practical or possible.  In 
this case, you'll have to resort to an educated guess. This isn't as hard as it sounds.

I recommend that the first time you call that you use 300 baud.  It is the lowest common denominator, as well as the 
slowest standard speed used.  Once connected (or "online", as we in "the biz" say), you can find out if the service supports 
a faster baud rate.

Next, let's talk about duplex.  Most professional computer services and bulletin board services (BBS's) will echo back the 
characters you type so they'll display on your screen.  For this reason, start out with FULL duplex.  If you can't see what 
you're typing, switch to HALF duplex.  If you are using HALF duplex and see double characters ("HHEELLOO"), switch to 
FULL duplex.  Stay away from ECHO duplex for now.  It's used when others will be calling your computer and will be 
discussed in detail in the chapter describing Red Ryder's "Host Mode" of operation.
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Pretty easy so far, eh?  This leaves only 3 parameters (Parity, Data Bits, and Stop Bits) with "billions and billions" of 
combinations.  Not to worry, only a few combinations are used by 99% of the systems out there.  The other 1%, of course, 
were put on this earth just to frustrate documentation writers who try to make things easy for beginners.

The first time you call a system, use NO Parity and 8 Data Bits.  If you get "garbage" characters or the other computer 
does not respond at all, wait a few seconds and then type the "RETURN" key a few times and see if that helps.  If you still 
have no luck, hang up, set your parameters to EVEN Parity and 7 Data Bits, and call back.  Most likely, one of these two 
settings will work.  If not, you're out of luck as far as an educated guess is concerned, and will have to get the information 
from the operators of the system.    You will probably never need to fool with Stop Bits, just set it to "1" and forget about it.  

Red Ryder does not "know" when you are connected to another computer.  Whatever you type at the keyboard is sent 
through the serial port.  If characters are received through the serial port, they are displayed as appropriate in the terminal 
window.  Therefore, you can send your modem's particular commands (such as for auto-dialing) just by typing directly to the 
modem.  Because Red Ryder is designed to support any modem that can be hooked up to a Macintosh, we do not discuss 
in detail the methods that are specific to various modems for such things as dialing and hanging up in this document.  You 
do need to read through the manual that came with your modem to exploit its capabilities with Red Ryder.
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Special Information For HFS Users

Unlike the original disk operating system supplied with the Macintosh, Apple's new Hierarchical File System (known as 
HFS) makes folders into true subdirectories, rather than just Finder grouping devices for appearance sake.  Numerous 
places throughout this manual, we discuss how to refer to a file's location on a disk by using its disk volume name, a colon, 
and then the filename.  Under an HFS system (like on Apple's HD20 hard disk), you need to actually describe a "path" to the 
file through all of the various folders between the file and the root directory (desktop).

It's not as difficult as it sounds, and here's how it works.  Under the old filing system, you would refer to a file named 
"TheFile" on a disk volume named "TheDisk" as "TheDisk:TheFile".  Folders didn't make a bit of difference.

Now here's an HFS example.  You have a disk named "TheDisk" which contains a folder called "Comm".  Inside that 
folder is another folder named "Data".  Inside the "Data" folder is a file called "TheFile".  The way you refer to it would be 
"TheDisk:Comm:Data:TheFile".  The order of the folders is important, as it gives Red Ryder a path to follow from the 
desktop to the file.  Therefore, all Red Ryder functions will work properly with HFS if you remember to substitute the above 
format for any reference to the volume name in this manual. Whenever we talk about a file being on the same disk volume 
as Red Ryder, you would add the words "and inside the same HFS folder".
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Starting Up Red Ryder

Prepare a fresh diskette with nothing but the System Folder and Red Ryder on it.  You can start up Red Ryder by either 
double-clicking on or single-clicking on and choosing Open from the Finder's File menu after selecting:

• The Red Ryder program icon.

• A Macro Keys file or Procedure file icon (both of which will be described later).

• The "Red's 8.0 Stuff" icon.  This document contains information that enables Red Ryder to remember many things 
about the last time Red was loaded in, such as parameters and macro key contents.  If you drag the "Red's 8.0 Stuff" icon 
into the trash before entering Red Ryder, default values will be used.

When Red Ryder is started up through its program icon, it displays a title screen.  After reading this, click your mouse 
button and a "terminal" display screen will appear after a brief delay.  If you start Red Ryder through a Macro Keys or 
Procedure file icon, the title screen will be bypassed.

You may wish to bypass the title screen for one reason or another (like being tired of seeing it).  There are two easy ways 
to do it.  One is to hold down your mouse button while the program is loading.  The other is to start up Red Ryder by double-
clicking the "Red's 8.0 Stuff" icon.

Certain Red Ryder menu commands bring up dialog boxes that have editable text choices.  The box that surrounds any 
editable text item is the exact size of the maximum number of characters that is allowed for that item.  Don't type more than 
that!
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Keyboard Preferences

Red Ryder has the capability to support many different needs as far as special keys are concerned.  Because there 
several keys found on other computers and terminals that are not found on the standard Macintosh keyboard, Red Ryder 
gives you the ability to "map" the keyboard to your special needs.  Browse through this information right now so that you 
know it exists.  Chances are you may never have to adjust Red Ryder's default settings unless you use VT100 or VT52 
terminal emulation, or communicate with a host that falls into the "oddball" category.

Under the Local menu, there is a Keyboard Preferences choice that brings up a dialog box with the following items:

If the Enter key Is ESC key choice is enabled, the Macintosh keyboard ENTER key sends an ESCAPE control character 
(ASCII code 27).  Otherwise, it sends a carriage return (ASCII code 13)   - exactly as the RETURN key, and perhaps a 
linefeed character - depending on the state of the Send LF after CR menu choice.

` Key is ESC key turns the right pointing accent (which is at the top left corner of the keyboard) into an ESCAPE key.  
This is to map the ESCAPE key to the same physical location it is on a VT100 keyboard.  The ESCAPE key is also 
commonly referred to as the "Gold Key" by many VT100 applications.  Note that there is not yet a way (except through a 
macro key) to send a right pointing accent character when this option is selected.

If the Backspace key is DEL key choice is enabled, the SHIFT-BACKSPACE key will send a DELETE control character 
(ASCII code 127).  Otherwise it will send a normal backspace control character (ASCII code 8).  If your BACKSPACE key 
doesn't seem to work right, check the state of this choice.

If the Modem BREAK signal keys supported choice is enabled, the keyboard sequence SHIFT BACKSPACE will send 
a short (233 millisecond) modem BREAK signal (if your modem supports it).  The keyboard sequence SHIFT COMMAND 
BACKSPACE will send a long (3 1/2 - 4 second) modem BREAK signal.

If the VT100 cursor key diamond supported is enabled, you can simulate the VT52/100 cursor keys with the following 
Macintosh keyboard combinations:

Macintosh Keyboard Action Sends:
COMMAND BACKSPACE Same as VT100/52 "up" cursor                       key.
COMMAND RETURN Same as VT100/52 "down" key.      COMMAND \

Same as VT100/52 "right" key.
COMMAND ] Same as VT100/52 "left" key.   

If you have an Apple numeric keypad connected to your Mac's keyboard (or a Macintosh+ Keyboard), its keys will 
function exactly like those on a VT100 keypad when VT100 or VT52 emulation is active.  The keys are mapped 
thusly:
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Because many VT100 applications map special keys to the above physical arrangement, it was my decision to map the 
VT100 keypad in its original alignment, rather than according to the characters physically printed on the Macintosh keycaps. 
It may cause you a little confusion at the start, but in the long run, it will cause the least amount of confusion.

There are three sets of ten Macro Keys each, discussed in more detail later, each set having keys numbered from 0 to 9. 
To execute a Macro Key, hold down the Command key and type the number of the Macro Key desired.  In other words, to 
execute Macro Key #1 from the current set, type 

"COMMAND 1".

In addition to the normal A-Z alphabet and punctuation characters we use in normal written communications, there are 
many additional characters significant for communicating by computer.  What they are and how they are used is really up to 
each individual service you'll connect with.  Many are standard, but don't bet your last dollar that any or all will be recognized 
until you've read the service's documentation or have had a chance to experiment.  Often, the correct characters to press 
will be displayed on your screen by the remote service at various times, like:

Press CTRL-S to pause, CTRL-Q to resume, or CTRL-C to quit.

The "CTRL", by the way, is a common abbreviation for "control".  A control character is used for various commands to the 
remote service.  A 'C' and a CTRL-C are two different characters and should not be confused or used interchangably.  

Since the Macintosh keyboard was not provided with a CONTROL key, an interesting dilemma confronted the author 
while writing Red Ryder. The COMMAND (cloverleaf symbol) key was a logical replacement for the CONTROL key, but the 
user would have to give up COMMAND key menu choice equivalents (which many users favor over the mouse in certain 
situations).  If the OPTION key were used to send control characters, several keys (the E, N, and U) would have to be 
pressed twice to send one character, since these are mapped internally by the Macintosh as for use with diacritical 
characters.

Perhaps it is wishy-washy, but it has been decided that the decision should be made by the user, on the basis of 
personal preference.  Therefore, the Keyboard Mapping dialog box allows you to decide whether to use the OPTION keys 
or the COMMAND key to send control characters.  If the COMMAND key is chosen, the menu-key equivalents are not 
displayed or supported.  Otherwise, they appear in the menus and can be used as shortcuts for menu choices. The NULL 
control character (ASCII code 0) can be sent by holding down your designated CONTROL key (OPTION or COMMAND) 
and pressing the SPACEBAR key.  To send a control character (CONTROL A to CONTROL Z is ASCII code 1 to ASCII code 
26), you hold down your designated CONTROL key and type the desired letter key.
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Legend:  OPTION is the key on the bottom left and bottom right corners of the keyboard.  COMMAND is to the right of 
the left OPTION key and has a "cloverleaf" symbol printed on it.  This version of Red Ryder is specifically for use with a 
"United States" keyboard.  A version will be available soon for various foreign Macintosh keyboard configurations.

The COMMAND and OPTION keys are used like a SHIFT key.  To send a CONTROL-A, you hold down the OPTION key 
and type an "A".

In this documentation, and in some character strings used by Red Ryder, we designate a control character by preceding 
it with a caret (^) symbol.  Some of the control characters you're likely to run across frequently are:

ASCII Code   Key  Typical Use
3 ^C Usually means "interrupt this function"
7 ^G Sound a "BELL" or beep
8 ^H Same as your BACKSPACE key
9 ^I Same as your TAB key
10 ^J A linefeed character
12 ^L Clear the screen or form-feed the printer
13 ^M Same as your RETURN key
17 ^Q XON character, tells other computer to resume

transmission after an XOFF.
19 ^S XOFF character, tells other computer to halt

transmission until an XON is received.
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Terminal Preferences

Red Ryder has the ability to emulate the functionality of three of the most widely used computer terminals.  The first and 
most common is called "TTY" (which is an abbreviation for Teletype).  This is also the simplest of the three emulations, since 
it works more like an electronic typewriter than anything else.  Unless you are told otherwise (or know better), you'll probably 
use TTY emulation for communicating with most host systems.

The second emulation is an exact duplication of the Digital Equipment Corporation's VT52 terminal. 

Finally, you may also choose to emulate the Digital Equipment Corporation's VT100 terminal.  This is a rather complex 
emulation, and the original terminal's function is not described in this manual, for details of what VT100 is and how it works, 
you should refer to the VT100 user manual from Digital Equipment Corporation.  What we will discuss is how Red Ryder 
emulates that terminal (a bit later).

Setting up how you want your terminal to function is done with two different menu commands under the Local menu: 
Remember Screens and Terminal Preferences.

Remember Screens makes your Macintosh remember the information that scrolls off the top of the screen.  Just how 
much of that information you want to remember is set by the dialog box that this menu command presents.  You can specify 
anywhere from 1 to 99 screens.  If you choose 1 screen, no lines are remembered that scroll off the top of the terminal 
window.  If you choose more than 1 screen, the right side of the terminal window has a vertical scroll bar that can be used to 
look at the remembered lines.

 Incidentally, 99 screens by my thumbnail calculation is equivalent to a Macintosh with a better than 45 foot high display 
screen!

As you might guess, the number of lines you can remember depends on the amount of free memory Red Ryder has 
available.  On a standard 512K Macintosh, you can comfortably remember 20 screens.  I'm sure you could press that limit 
much higher (I've gone as high as 65 screens while holding my breath), but it's a good idea to leave some memory available 
for desk accessories, copying, and pasting.  If you try to remember more screens than there is memory available for, a 
dialog box will tell you so and Red Ryder will revert back to remembering only 1 screen.  Therefore, if you will be running 
Red Ryder with Switcher and/or a RAM disk, and need to experiment with just how many screens you can remember, I 
would suggest you incrementally try more screens until you get the "Not enough memory" alert box.  Subtract 5 screens 
from the highest number you can work with without getting that alert box and you've left a safe amount of free memory.

Under the Local menu, there are four additional commands for getting rid or or saving received information.  If you want 
to clear out all of the remembered lines (including the current display screen), select Clear All Screens.  If you want to keep 
the remembered lines on hand but erase just the current (most recently received) screen, select Clear Display Screen.  
Let's say you want to dump all of the remembered lines to a disk file, so you can load them into MacWrite (or your favorite 
editor/word processor) for further manipulation at a later time.  The Archive All Screens command will add all of the 
remembered lines in the order they were received to a text file (on the same disk as Red Ryder) titled "Archived Screens".  
Unlike the "Dump Screen To Disk File" button on the General Status Bar, the archive functions do not delete the old 
"Archived Screens" file, they instead concatenate the new information at the end of the old file (if it exists, otherwise a new 
"Archived Screens" file will be created).  What if you want to just archive the current display screen?  Just choose the 
Archive Display Screen command!
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The Terminal Preferences menu command presents a dialog box containing several options for display performance.  
They are:

• Display (columns by lines) - this tells Red Ryder which of three screen displays to use.  40 characters by 12 lines uses 
a rather large font that is useful for people who have impaired vision. It can be used only with TTY emulation.  Since it takes 
a bit longer to draw the larger characters, I recommend you use it only at 300 baud.

80 characters by 24 lines is by far the most commonly used screen display.  It can be used with any type of terminal 
emulation.

132 characters by 24 lines is for use with TTY and VT100 emulation.  Since there is not enough room to display 132 
characters across the terminal window (without using a tiny font that would have made people curse me through clenched 
teeth and crossed eyes for eternity), this display uses a horizontal scroll bar at the bottom of the terminal window to display 
the rightmost 52 characters.

• Cursor style - you can choose a flashing or block cursor (or both) as opposed to a non-flashing or underline cursor (or 
both), depending on what is best for your needs and least distracting to you.  A flashing cursor is best for use with VT100 
emulation, where there can be inverse video text that could hide the cursor if it didn't flash.

• Terminal emulation - this is where you choose what kind of terminal you wish to emulate: TTY, VT100, or VT52.  If you 
aren't sure what to use, choose TTY unless you are told otherwise by the host system's documentation.

• Send linefeed after carriage return - if the characters you type appear perfectly on your screen but the host system 
does not respond when you press the RETURN key, chances are it needs an additional character after the carriage return 
called a linefeed character.  Don't select this option indiscriminantly, some host systems will not function correctly if this 
option is turned on.

• Modem is connected to - this choice let's you tell Red Ryder which serial port (the modem or printer port) you have the 
modem connected.  Apple suggests that you do not use the printer port at a higher baud rate than 300, but that may be 
hedging. I have used it at 1200 baud with no apparent problems.

• Remember lines before full screen clear - rather than scrolling lines off the top, some host systems like to erase the 
current display screen before presenting new information.  Unfortunately, this doesn't scroll any lines into that nice big buffer 
you set up with the Remember Screens menu command.  With this option selected, Red Ryder will take a "erase current 
screen" command from the host system to mean the same as if the host system sent 24 carriage returns.  This has the nice 
effect of pushing a "snapshot" of the display screen into the Remember Screens buffer before erasing the screen.

• Enable CompuServe 'RLE' graphics - CompuServe (a large commercial host system ), has the ability to send certain 
kinds of information (like radar weather maps or pictures of the FBI's Ten Most Wanted Fugitives) using either medium or 
high resolution graphics. Red Ryder supports both of these graphics modes (both are referred to as 'RLE' or 'Vidtex' 
graphics by CompuServe) if this choice is selected.  If when you tell CompuServe to send a graphic item it displays a 
message to the effect that your terminal is not capable of receiving the graphics, just ignore that message and proceed.  The 
graphics image will be displayed in the center of the terminal window, and will be framed by a rectangle when the complete 
image has been received.  At this point of Red Ryder's evolution (hint, hint), there isn't much you can do except admire the 
pretty picture.  However, you can use the standard methods (pressing COMMAND-SHIFT-3 or COMMAND-SHIFT-4) to 
send the window display to the printer or MacPaint compatible disk file.  Note that anything you do to cover the graphics 
image (like opening a desk accessory window) will destroy the image - it will not be repainted and it is not saved in the 
Remember Screens buffer.  This option should be turned off when you are not communicating with CompuServe.  I also 
recommend that it not be used with VT52 emulation, as the control character sequence that starts a graphics transfer 
conflicts with a VT52 control character sequence.
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The Terminal Display

At the top of your screen is the menu bar, containing many different choices and commands that we'll discuss in detail.  
Directly below the menu bar is the terminal window.  When you first execute Red Ryder, the terminal display is divided into 
two parts: the bottom is the communications area, where received characters are displayed, and the top is the Status Bar 
area.  There are 4 different status bars, but one of the most useful is called the General Status Bar.  This status bar is 
divided into several parts, they are from left to right:

• Elapsed timer - this displays the number of hours, minutes, and seconds since the timer was last reset (or Red Ryder 
was executed).  To reset the timer to 00:00:00, just click your mouse in that section of the status bar.

Some tools, left to right:

• Dump Screen To Printer Button - When you click in this box the text that is currently displayed in the terminal window is 
printed out on your printer if it is connected, turned on, and selected.   If the printer is turned on but the "Select" light on the 
printer in not on, Red Ryder will wait for you to press the printer's "Select" button.  Each time you click this box, any prior 
"Current Screen" disk file is destroyed in favor of the new.

• CTRL-S/CTRL-Q Toggle Button - Clicking on this button once sends a CTRL-S character, which many systems support 
as meaning "pause your output".  Clicking on it again sends a CTRL-Q character, which to many systems means "resume 
the output", after it has been paused.

•Dump Screen To Disk Button - When you click in this button, the current display screen is saved in a TEXT file on the 
same disk as Red Ryder titled "Current Screen".  Each time you click this button, the old "Current Screen" file is destroyed 
and a new one created.

• Protocol Selection And Display Box - This box displays the current communications protocol you are using.  To change 
any of the individual parameters, just click on them: they change in rotation.  The parameters are displayed from left to right 
as:

BAUD RATE-PARITY-DATA BITS-STOP BITS-DUPLEX

So, if the parameters area displayed:

300-N-8-1-FULL

You would be using 300 Baud, NO Parity, 8 Data Bits, 1 Stop Bit, and FULL Duplex.  Notice that only the first character of 
the Parity parameter is displayed.  NO Parity is displayed as "N", EVEN as "E", ODD as "O", MARK as "K" (because an "M" 
looks too much like an "N"), and SPACE as "S".
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• Finally, the rightmost section of the General Status Bar looks like this:

These are three Control Character Buttons and are used to send control characters quickly with your mouse.  To send 
a CTRL-S character, you would click inside the circle to the left of the characters "^S" above.  The caret character is used 
throughout Red Ryder to mean that the symbol following it is actually a control character.  You'll see it used this way in 
several other places.  You'll notice there is some redundancy between the default characters in these buttons and the CTRL-
S/CTRL-Q Toggle Button, but you can actually customize these three buttons to display any three control characters you 
wish by selecting the Edit Control Buttons Choice under the Edit menu.
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Macro Keys

Once you've started using various services regularly, you'll find that you'll be typing many of the same words and 
commands over and over.  Macro Keys are used to send up to 40 pre-stored characters with only one keystroke.  There are 
30 macro keys, divided into 3 sets of ten keys each.  Each set has macro keys numbered 0 to 9.  To send a macro key, you 
hold down the COMMAND key and type a numeral from 0 to 9 corresponding to the Macro Key you wish to send.  To make 
one of the three sets "active" (choosable with the mouse or keyboard), you'll use the scroll buttons in the Macros Status Bar 
as described a little later.

To store characters inside a macro key, select the Edit Macro Keys choice from the Edit menu.  You'll first see a dialog 
box asking you to specify which set and macro key number in that set to edit.  After choosing the set and key number, you'll 
see a new dialog box with two editable text boxes.  The top box is titled "String:" and it contains the actual characters you 
wish that macro key to send.  The bottom box is titled "Label:", and it contains a "name" you wish to give to that key.

The label can be up to 13 characters long.  They are used to describe what that macro key does, and they show up in 
the macro key buttons in the Macros Status Bar. 

A carriage return character is not automatically sent at the end of a macro key.  However, it just so happens that there is 
a way to embed control characters in a macro key string, and there is a certain control character that is the same as what 
your RETURN key sends.  This control character is CTRL-M.  You specify control characters by preceding it with a caret 
character.  To send a caret character, type in two carets side by side.

Here's an unlikely (but illustrative) example:

HELLO^ETHERE^^BOB^M

This example would send the characters "HELLO", followed by a CONTROL E, followed by the characters "THERE" 
followed by a single caret character, followed by the characters "BOB", followed by a carriage return (which is the same a 
CONTROL M).

If the above makes perfect sense, you're in good shape.  Otherwise, you need to go back and review the last few 
paragraphs until it is clearer.

For the most part, the only control character you'll probably need to ever use is CONTROL M for carriage returns.  Just 
remember that:

HELLO THERE^M

would send a carriage return at the end of "HELLO THERE", and:

HELLO THERE

would not.  For those of you who have found the need to send linefeeds after carriage returns, your "magic" sequence 
becomes:

HELLO THERE^M^J
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Macro keys are useful for holding passwords, commonly used commands, and even quick and dirty modem dialing 
commands.  If you have a Hayes compatible modem you could set up a macro key that contains:

ATDT 555-1212^M

When you sent that macro key, it would issue the appropriate dialing command to dial touch-tone the number 555-1212.  
Please change that number before experimenting or you'll have a Directory Assistance operator who thinks he/she has a 
"breather" on the line while you're busy celebrating success.

Remember that each macro key can only hold 40 characters, including any caret characters.  If you try to enter more 
than 40, the surplus will be "lopped off" into oblivion.

Like most Mac users, you'll probably want to use your mouse as much as possible.  Remember how we discussed the 
General Status Bar earlier?  There's also a status bar for Macro Keys called (obviously) the Macros Status Bar.  You can 
have a look at this by selecting that choice from under the Mode menu.  Here's a partial Macros Status Bar I set up:

Each Macro Key's label is shown in its respective box to help you identify its purpose.  The top row of boxes displays 
Macro Keys numbers 0-4, (from left to right), and the bottom row displays Macro Keys numbers 5-9.  To send a Macro Key, 
simply click your mouse inside the appropriate box.

On the right hand side of the Macro Key Buttons you see a downward pointing arrow.  By clicking this, you will scroll 
through the three sets of Macro Keys, making each set "active" (that is, choosable through the Macro Key Buttons and 
keyboard).  To the right of that is the elapsed time clock, exactly the same as the one in the General Status Bar.

Of course, you might doubt that a 40 character Macro Key could hold enough poop to do something as complicated as 
"Get E-Mail" implies, and you're right.  

A Macro Key string that begins with a backslash (which is directly above the RETURN key on your keyboard and not to 
be confused with the slash ("/") character)  specifies not a string of characters to send, but instead the name of a 
Procedure file you wish to execute immediately.  This is a quicker way of executing Procedures than going through menu 
choices. 

If you set up a Macro Key in this way and hear two "beeps" when you click on the box, it means Red Ryder can't 
locate the Procedure file.  It either doesn't exist by that name, or it isn't located on the same disk as Red Ryder.  To 
execute a Procedure file on a disk other than the one Red Ryder is on, you need to precede the Procedure file name 
with the volume name it's located on.

In other words, if the Procedure file named CALL COMPUSERVE is located on the disk named MY PROCEDURES, you 
would need to set up the Macro Key to read:

\MY PROCEDURES:CALL COMPUSERVE
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The colon character is what separates the volume and file names.  It's really a good idea to specify volume names no 
matter where the file is located, in order to avoid trouble later.

You'll soon find that even 30 Macro Keys just aren't enough for your ever-growing sophisticated needs.  Red Ryder 
allows you to save your Macro Keys in a disk file to be loaded in at a later date.  Simply choose the appropriate choice Save 
Macro Keys or Load Macro Keys from the Edit menu to accomplish this.  You'll find the Macro Keys file has a distinctive 
icon that looks like the one next to the Edit Macro Keys choice under the Edit menu.  You can double-click on this icon (or 
single-click and select Open from the Finder's File menu) to start up Red Ryder.  If you start it up this way, the Macro Key 
file you clicked will be immediately loaded in.

You can also use macro keys to set up special escape-code command sequences used by VT52 and VT100 
applications.  To send an ESCAPE control character, use the sequence "^[" (caret-left square bracket).

There are also a few VT100 applications that use both the Backspace and DEL keys for different things in the same 
session.  I suggest you select the "Backspace Key Is DEL Key" in the Keyboard Preferences menu command, and then 
put the string "^H" (caret-H) in a Macro Key button with the lable "Backspace".  This works because a CTRL-H is what the 
Backspace key normally sends.
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Automatic Dialing And Redialing

Getting a lot of busy signals?  Welcome to the world of BBS'ing!  It would seem that every sticky-fingered kid with a 
Timex computer and a modem is committed to either getting into a BBS before you or reaching puberty first.  Fortunately, we 
do not make a version of Red Ryder for Timex computers.  If you have a Hayes compatible modem, you have probably 
discovered (as we discussed at the end of the "Setting Up Red Ryder" chapter) that you can dial a number by typing in the 
modem dialing command on the terminal display screen.  Now let's add a little horsepower to our digits!

Select the Dial Or Redial A Number choice from the Service menu.  You are now presented with a text entry box that 
you'll type the modem dialing command and phone number into, and three buttons: "Redial", "Dial", and "Cancel".  Clicking 
on the "Cancel" button returns you to the terminal display screen without doing anything.  Otherwise, type in the modem 
dialing command and click on either Dial or Redial.  You don't need to put a ^M at the end of the dialing command - Red 
Ryder sends a carriage return automatically.  You can, however, embed control characters in a dialing string in the same 
manner you would a Macro Key string.  I don't know why you would want to, but I'm sure somebody will find a reason.

  Remember that the dialing string must contain all of the information needed by your modem.  If the dialing string you 
entered looked like this:

555-1212

it's likely that nothing would happen.  With a Hayes modem, you would need to precede the number to be dialed with 
either ATDT (for touch-tone) or ATDP (for pulse), making the correct dialing string look like:

ATDT 555-1212

Once you have the command entered in, click on the "Dial" button.  The modem should respond to the command and 
dial the number (if it doesn't, you need to check your modem's documentation on how to set it up correctly).  Let's say you 
get a busy signal.  Go back up to the Service menu and again select the Dial Or Redial A Number choice.  You'll see that 
the last dialing command entered is still in the text entry box, so you can just click on the "Dial" button to dial that number 
again.

 
To automate this process, you can skip the "Dial" button stuff and click on the "Redial" button or press the RETURN key 

instead.  Now the status bar is replaced with a redialing status message, showing you the redial attempt in process.  Your 
keyboard and menu bar are locked out during redialing: to cancel the redial, press your mouse button until the status bar 
area is graphically inverted (white on black), then release it.

During the redial, Red Ryder sends out the dialing string and waits for one of three messages to come back from your 
modem:

CONNECT - meaning you have established a connection
NO CARRIER - meaning the other guy is busy or not answering
BUSY - meaning the other guy is busy

If the modem dials only once (and never again), it's because one of these three messages are never sent back to Red 
Ryder by the modem.
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If the NO CARRIER or BUSY message is received, Red pauses for a few seconds and then repeats the whole routine.  
If the CONNECT message is received, Red starts beeping wildly to alert you.  When it's got your attention, press and hold 
your mouse button until the beeping stops and the status bar area graphically inverts.  You will then be ready to begin your 
log in routine.  This feature is designed so that you can go water the dog, walk the spouse, or watch Larry put a mojo on 
Curly while Red busily dials away.  If you're going to use it, be responsible and make sure you type in the right number! 

You are advised to find out if there are regulations applicable to you that limit the number of redial attempts you can 
make.  It's a good idea to stay nearby until you get the "Attempt #2" message.  Once you get this, everything is working fine 
and you can leave it unattended.  The amount of time your modem will sit and listen to a busy signal before reporting NO 
CARRIER is adjustable on some Hayes compatible modems, but not all (check your documentation).  The default is usually 
30 seconds which is fine for most needs.

If you have trouble getting the redial to work, check that the modem is capable of and set up to return at least the 
CONNECT and NO CARRIER messages.  Only some modems will return the BUSY message (like the Anchor Signalman 
Mark XII).  Also be sure that your modem is ready to accept a dialing command.  If you change one or more communications 
parameters or dial in a partial modem command and then change your mind, it may be necessary to type in "AT" and a 
carriage return several times until your Hayes compatible modem returns an "OK" message.

Finally, please be smart about how you use the redial feature.  When I used to operate a BBS in my home, it had the bad 
habit of crashing every day or two (this was before I wrote Red Ryder Host - it was operated on an IBM-PC I had gathering 
dust in the back room).  It was easy to tell when the BBS crashed, because some jerk would then decide to start redialing 
my voice line (just to see if there was a BBS connected there, I suppose).  Of course, he turned off his modem speaker so 
as not wake anyone in his home at 3 a.m., and therefore couldn't hear me screaming "Hullo?" (or much worse).  The net 
effect was that my phone would ring twice per minute for several hours on end.  One night, I got very angry and answered 
the phone - twice per minute - for over three hours.  I suspect he got the message when his phone bill arrived the next 
month - I hope he was calling from Boise.  The moral of this story is, don't redial a number you absolutely aren't positive is 
connected to a computer.
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Terminal Emulation Details

Red Ryder can emulate three terminal types: a teletype (TTY), a DEC VT100, and a DEC VT52. The type of terminal 
Red Ryder emulates is selected by the Terminal Preferences command under the Local menu.  Let's look at each of the 
terminal types and how Red Ryder emulates them.

Terminal emulation defines how Red Ryder reacts to certain control characters sent by the remote system.  TTY 
emulation, for instance, has a few very simple commands for clearing the screen, moving the cursor to the next line, 
backspacing, and tabbing.  VT52 emulation adds several additional screen formatting controls, such as those to allow the 
quick placement of the cursor anywhere on the screen.  VT100 emulation is the most advanced of the three, allowing such 
things as selective scrolling, character attributes such as boldface and underlining, and tab stop placement under host 
system control.

TTY is what you should use the first time you call if you don't know what the remote system expects.  If the remote 
system asks you to explain what terminal type you have and you don't see "TTY" listed, look for other descriptions that imply 
a non-specific terminal type, such as "CRT" or "OTHER".  VT52 and VT100 emulation is provided in Red Ryder mainly for 
those who are experienced with using the real thing, since no attempt is made to duplicate the VT100 or VT52 User's 
Manual here.  Those who are familiar with these terminals and their use should have little trouble adjusting to the emulation 
done by Red Ryder.

If you don't expect to use the VT52 or VT100 emulations, you can skip ahead to the next chapter.

The VT100 and VT52 terminals both have several keys and status lights not found on a Macintosh.  Therefore, Red 
Ryder makes use of the mouse and a special VT100 Status Bar, which can be selected from under the Special menu.  This 
status bar responds to mouse clicks only when VT52 or VT100 emulation is active.  It is divided into three functional 
sections.  From left to right they are:

Special Keys And Status Lights:  The top row contains the four special keys PF1, PF2, PF3, and PF4.  The control codes 
sent by these keys are affected by the VT100/VT52 "Keypad Mode".  The bottom row contains the 4 LED status lights.  
When lit, the LED's are displayed as white characters on a black background.  The LED's are not buttons!

Cursor Movement Keys:  The keys are arranged in an "inverted T" arrangement for quick movement of the cursor.  The 
two blank boxes are unused.  The control codes sent by these keys are affected by the VT100 "Cursor Key Mode".  Since 
you may wish to use a different status bar than the VT100 status bar, you can simulate the cursor keys by holding down the 
COMMAND key and pressing one of the keys in the diamond formed by the keys BACKSPACE (up), backslash (right), right 
square bracket (left), and RETURN (down).  The "VT100 Cursor Key Diamond Supported" choice in the Keyboard 
Preferences dialog box must be turned on for these keys to function.

Numeric Keypad: These keys emulate the numeric keypad.  The "ENTER" in this Status Bar is the same as the 
"RETURN" key on the Macintosh keyboard, not the Enter key next to the spacebar.  The control codes sent by these keys 
are affected by the VT100/VT52 "Keypad Mode".



Red Ryder Version 8.0 Documentation                                           Pg. 
25

VT52 Emulation Details

The VT52 is emulated in the same manner a DEC VT100 operates in its "VT52 Compatible Mode".  All of the emulation 
attributes are preserved, including the "Keypad Mode" (which can be set or reset manually by selecting the VT100 Keypad 
Mode and VT100 Cursor Key Mode choices under the VT100 Modes menu choice) and the special graphics character set.

VT100 Emulation Details     

A lot of terminal programs purport to emulate a DEC VT100.  I can guarantee that many don't even come close.  From a 
programmer's standpoint, doing a good VT100 is easy.  Doing a very good VT100 is difficult.  Doing a usable VT100 is so 
damn hard that it's rare.  Every VT100 emulation has inherent deficiencies that you should be aware of.  Rather than 
"forgetting to mention them", I think it's better to come right out up front and tell you exactly what you can expect. 

As much of the native VT100 environment as practical is emulated in Red Ryder.  The functions not emulated will not be 
of consequence to the vast majority of users, but are listed here as a matter of integrity.  The functions not emulated include:

1) Double-high/double-wide and Single-high/double wide characters. Probably will be 
supported in a future version.

2) Smooth scroll mode.
3) Screen mode (inverse screen mode not supported).
4) Interlace mode (hardware dependent - will not be emulated in future!).
5) Blink character attribute (shown as inverse attribute).

I recommend selecting Flashing Cursor with the Terminal Preferences menu command to help you easily locate the 
position of the cursor when it rests on top of a character having the inverse attribute.

  The VT100 terminal has several "modes" of operation that affect what characters the keypad and cursor movement 
keys send, as well as the appearance and function of the terminal display.  Several of the VT100 modes can be manually 
set or reset through choices through the VT100 Modes command under the Special menu.  A mode is considered "set" 
when a checkmark appears in its dialog box choice.  The choices in the dialog box this command presents are:

Graphics Character Set Available - Red Ryder supports both the VT52 and VT100 special graphics character set as 
well as the United Kingdom character set.  Selecting this choice allows the remote computer to select and use them.

VT100 Wraparound: When set, cursor jumps to the beginning of the next line when it reachs the rightmost column.  
When reset, the cursor remains in the rightmost column and characters are overwritten in that column.  

VT100 Autorepeat:  When set, most keyboard characters repeat continuously when held down.  This includes the keys 
on the VT100 Status Bar.  When reset, no keys are repeated.
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VT100 Cursor Key and VT100 Keypad:  when set or reset, these modes affect the control codes that are sent for their 
respective keys.

VT100 Newline: When set, a received linefeed character moves the cursor to the leftmost position of the next downward 
line.  The RETURN key sends both a carriage return and linefeed character.  When reset, the linefeed moves the cursor 
downward vertically only, and the RETURN key sends only a carriage return.

  If you are not experienced with the consequences of the above modes, do not manually change them (unless the 
remote application specifically tells you to) without consulting the system operator of the remote system.  The default 
settings should work with the majority of remote applications.  If things work in strange ways upon starting up Red Ryder, the 
remote application probably didn't reset these modes properly.  Trying deleting the "Red's Stuff" file from the Finder, and 
then re-executing Red Ryder so that a new defaults file will be created.  Another way to "cold-start" the VT100 emulation is 
to switch to TTY emulation, then back to VT100 emulation through the Terminal Preferences menu command.

  
  You can also tell Red Ryder to respond to a certain control character sent by the remote computer (an ASCII code 5 

(CTRL-E) for those who wonder) with a predefined string of characters known to VT100 users as the "answerback 
message".  This string may contain up to 30 characters, and may include control characters (such as a ^M for a carriage 
return) in a similar manner as they are included in Macro Key strings.

The VT-Mouse™

  You'll find that jack-hammering the cursor movement keys can be quite tiring and hard to follow.  Since we've got a 
mouse on our Mac, let's use  it!  If you hold down your Option key when VT52 or VT100 emulation is active, you'll see that 
the mouse cursor turns into a small rectangle whenever it is moved into the text area of the display screen.  You'll find that 
this rectangle fits snugly around a character of text as shown above.  Clicking your mouse will cause Red Ryder to send the 
appropriate series of cursor movement keys to move the cursor to that row and column.  A great deal of time has been spent 
to make sure that this routine works as documented, but I've found that some VT100 editors use some very bizarre input 
throttling and cursor movement optimization methods.  The heuristics incorporated into the VT-Mouse feature are as follows:

• When you execute the VT-Mouse, it looks at where the cursor currently is and where it needs to go.  It sends the proper 
cursor movement key codes to move in the right direction towards the destination.

• It waits until the host sends the codes meaning "I got your request to move.  OK, move it!".  If this isn't received within 5 
seconds, the VT-Mouse routine gives up.

• It looks at where the cursor is now and repeats this cycle until it gets to where you specified you wanted it to go.

Even with this intelligence, it is still possible to overrun the host's ability to process the incoming cursor movement keys.  
The symptom is a group of seemingly random "garbage" characters dumped in the middle of your text.  The solution is to 
increase the VT-Mouse delay value in the VT100 Modes dialog box.  This delay value ranges from 0 to 60.  It specifies in 
1/60th of a second increments how long to wait before sending the next cursor movement key.  Note that this value does not 
affect the auto-repeat rate of the keyboard or VT100 Status Bar cursor movement keys.
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Overrunning can also be caused in some cases through the keyboard and VT100 Status Bar cursor movement keys.  
The solution is to slow down the keyboard repeat rate (in the Macintosh Control Panel desk accessory) and to use the VT-
Mouse (with its added intelligence) rather than letting the VT100 Status Bar cursor movement key buttons auto-repeat.



Red Ryder Version 8.0 Documentation                                           Pg. 
28

Massaging Your Data

One of Red Ryder's strong points is the extraordinarily large number of choices you have for manipulating data once it's 
been received.  The Remember Screens buffer is useful when you don't anticipate the need to save data, but don't want to 
lose something important once it's been received.  The Dump Screen To Printer and Dump Screen To Disk File buttons on 
the General Status Bar, in conjunction with the Archive Display Screen and Archive All Screens menu choices give you 
the flexibility you need to make snap decisions about saving information.

There are also two methods available for "capturing" all incoming information and routing it to either the printer, a disk 
TEXT file, or both.  Under the Local menu, select the Echo To Printer menu choice and Red Ryder will route all received 
data not only to the screen, but also to your printer.  Take note that the Imagewriter (but not the Imagewriter II model) is not 
fast enough to keep up at 1200 baud.  However, Red Ryder will attempt to "throttle" the host with CTRL-S and CTRL-Q 
characters when the printer starts to lag, so you should not lose any data.  Unless you intend to toggle this menu choice at 
various times during a session, you're better off connecting at 300 baud, a speed at which the Imagewriter can easily keep 
up (and you'll likely be charged less for by the host system).

The Receive File - ASCII menu choice under the File menu similarly routes a copy of all received data to a disk TEXT 
file.

 Note that if you are using HALF duplex, a copy of everything you type is also sent to the printer or disk TEXT file.

To stop routing information to the printer, you again select the Echo To Printer menu choice so that its checkmark is 
removed.  To stop routing information to a disk TEXT file, you choose the End File Receive menu choice under the File 
menu.  That menu choice only appears after you select the Receive File - ASCII menu choice.

The converse of receiving to a disk TEXT file is sending a disk TEXT file to the modem.  By doing this, we can actually 
compose mail offline and then "zip" it to the host once connected.  The Send File - ASCII menu choice under the File menu 
accomplishes this.  You don't have to manually end this function like you do the Receive File - ASCII function, it 
automatically stops when it has sent the last character in the disk TEXT file.  You can, however, stop the Send File - ASCII 
function before it would normally end by selecting the Cancel File Send menu choice under the File menu.  Again, that 
menu choice appears only after you choose the Send File - ASCII menu command.

What is this ASCII stuff, anyway?  What is actually sent over the modem are individual numeric codes ranging in value 
from 0 to 255.  Those are not "magic" values, they are the same values that one "byte" of computer information can hold. 
That means that every byte of your computer's memory holds a number between 0 and 255.   ASCII (it's pronounced ass'- 
key) is nothing more than an agreement between those writing computer software.  This agreement covers how to display 
textual information on the screen.  We agree, for instance, to display an ASCII code 65 as a capital 'A' character.  An ASCII 
code 43 is displayed as a '+' character.  There are code equivalents for every key on your keyboard (and a few more that 
have fallen into the twilight zone over the years).

The codes 0 to 127 are defined in the ASCII agreement, which covers every character on the U.S. keyboard.  Some 
codes don't specify characters, but actions to take.  For instance, an ASCII code 13 is called a carriage return, and an ASCII 
code 10 is called a linefeed.  The codes below 31 are what we call CONTROL characters.
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This is where things have become a bit muddied.  Some computers feel that a carriage return means just put the cursor 
at the beginning of the current line.  A linefeed drops the cursor to the same position, but a line lower.  For these computers, 
the equivalent of hitting the carriage return key on a typewriter is a carriage return character followed by a linefeed 
character.

Other computers, like the Macintosh, feel that a carriage return character alone is sufficient to mean "that's the end of 
this line, drop down to the beginning of the next line".  That computer would just ignore linefeed characters.

That's all fine for terminal displays, but let's say you choose Receive A File - ASCII from the File menu.  Red Ryder is 
smart enough to handle the screen properly, but MacWrite is not.  If you load in a saved TEXT file that contains linefeed 
characters (or other control characters meaningless to MacWrite), what you'll see is a file sprinkled with those ugly rectangle 
characters at the beginning of every line.

What we need is to add a bit of intelligence to our ASCII file handling routines, and Red Ryder has got a lot of smarts in 
this category.  By choosing the ASCII File Transfer Preferences choice under the File menu, you are presented with a 
myriad of options to help you accomplish your goal.

• Wait after each line sent for - if you checkmark this box and type a character in its editable text item, Red Ryder will 
wait after each line sent (by the Send File - ASCII menu command) for the host to send the specified character before 
sending the next line.  Its use?  Let's say your favorite host system prompts you to type in each line of a message with a '>' 
character.  You could then type in the message offline (using an editor/word processing application), and use this option to 
send the message one line at a time in response to the host system's prompt.  If you are technically inclined, you can 
actually enter a control character to wait for by using Red Ryder's caret-character convention (^S for instance).

• Delay after each - you can also tell Red Ryder to delay after each character or line sent for a certain length of time (if it 
tends to lose characters).  The between-character delay is in 1/60th of a second increments, and the between-line delay is 
in 1 second increments.

• Received TEXT file creator - The Macintosh has the neat ability to load in a specific application when you double-click 
on a document icon.  Notice how when you double-click on a Macro Keys file, it automatically starts up Red Ryder?  You can 
do the same with all files received with the Receive File - ASCII menu choice.  Each Mac program uses a 4 character 
"creator" name to identify its documents.  MACA is the creator name for MacWrite.  This option let's you specify what 
editor/word processor to automatically start up when you double-click on the TEXT file's document icon.  We'll publish a list 
of the various creator names for the popular editor/word processors in the FreeSoft RoundTable on the GEnie host system.

• Strip control characters from received files - when checkmarked, this option does not save any characters that 
would cause those ugly rectangle characters to appear in file as we discussed before.

• Force line ends in sent files at - most Macintosh editor/word processors allow you to type in lines longer than the host 
you are sending them to can swallow.  This option let's you specify at what column Red Ryder is to send a carriage return if 
it gets that far without having a carriage return appear in the line.  Notice that this doesn't do any word-wrapping.  It's a 
safety valve feature that may result in words being chopped off in the middle and the "pretty" format of your file made 
awkward.  Your host system will probably tell you explicitly what its maximum line length is for message entry.  We 
recommend that you do not rely on this feature, but instead type your message with the host system's limits in mind.  Don't 
allow word-wrapping in your editor/word processor to end lines, explicitly do so by typing a carriage return at the end of each 
line.
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Under the Local menu, there are two additional commands you can use to aid you in your work.  The Print TEXT File 
command allows you to copy a disk file to the printer without having to leave Red Ryder.  If you want to get rid of no longer 
needed disk files (any disk files, not just TEXT files!), use the Delete A File menu command.  This command will verify that 
you actually want to destroy a file before deleting it.
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Tab Stops

A Tab Stop is one of those inconsistantly defined kind of things.  Let's say you wanted to correct some numbers on a 
colleague's typewritten report.  You could easily put the paper into your typewriter, but your Tab Stops are probably not set at 
the same position your colleague's typewriter had them set.  Therefore, you need to manually adjust where the Tab Stops 
are in order to easily work with the report.

Red Ryder sets Tab Stops at every 8 columns as a default.  You can get rid of all Tab Stops by choosing the Clear All 
Tab Stops choice under the Local menu.  Your host system may explicitly tell you at what columns its Tab Stops are set at, 
but how do you change Red Ryder to honor those?  Under the Special menu, choose the Tabs Status Bar command.

The status bar portion of the terminal window then shows a column ruler with small black diamond characters beneath 
each column that contains a Tab Stop.  The number at the very left of the ruler corresponds to the leftmost column on your 
display screen.  To set a Tab Stop, just click on the desired column.  To remove a Tab Stop, just click again on that column.

Two warnings here.  First, realize that unless your host system instructs you where to put them, your Tab Stops may not 
be in similar positions.  Secondly, if your Tab Stops seem to move around on you, it's probably because a VT100 application 
set them automatically where it desired them (VT100 emulation has that capability).  Tab Stop positions are kept in the 
"Red's 8.0 Stuff" file, so if you have a standard setup you wish to keep, you may wish to make a copy of that file, and then 
rename it to "Red's 8.0 Stuff" before executing Red Ryder.
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Copying And Pasting

Red Ryder supports the Macintosh clipboard in a standard manner for moving information between applications.  You 
use your mouse cursor to select text in the standard method.  Note that you can only scroll in a downward direction, so the 
proper practice is to move the vertical scroll bar to display the top of the text you wish to select, and then use the mouse to 
scroll downwards through the document.  Let's look at the commands under the Edit menu, and how they are used by Red 
Ryder.

There is no Undo or Cut equivalent for Red Ryder.  Those commands are only available when a desk accessory is open 
(and may or may not be supported by a particular desk accessory).  The Copy command is used to duplicate the selected 
text in the Macintosh's Clipboard.  It could then be Pasted into an editor/word processor just as it appears on your display 
screen.  Apple warns that the Copy command is to be used for relatively small amounts of information.  The reason for this 
is that a copy of the selected text must be created in memory before it can be dumped to the Clipboard File on the disk (100 
characters or less is kept in memory during Red Ryder use, and then placed in the Clipboard File on the disk before Red 
Ryder exits to the Finder).  Therefore, don't even think about putting a brick on your mouse button to select 20 screens of 
remembered lines, and then choosing Copy from the Edit menu.

When a desk accessory is open, the Paste command copies information from the Clipboard to the accessory (if it's able 
to accept it).  When an accessory is not open, this menu command reads Paste To Modem and it does exactly that.  Think 
of it as making the Macintosh Clipboard an equivalent to a Red Ryder Macro Key if this doesn't make sense.  There are lots 
of tricks you can make use of with this feature.  One of my favorites is to put a list of BBS's I like to call in my Notepad, along 
with their modem dialing commands.  I just Copy the modem dialing command from the Notepad, and then select Paste To 
Modem after closing the Notepad.

The Clear menu command simply erases whatever is in the Clipboard.

Copy Table is useful for copying a table of numbers (or whatever) in columnar format that you'll later want to Paste into 
a spreadsheet or database program.  Before putting the information into the Clipboard, Red Ryder turns the spaces between 
each column into a single Tab character, which most spreadsheet and database programs are happy to accept.  The 
Clipboard information then goes by the name of "Tab delimited data".

Let's say you're zipping along in a session and then run across a fantastic recipe for Guacamole Dip. You can select the 
text of the recipe with the mouse and then choose the Print Selected Text menu command.  Presto!  Only the lines you 
want are sent to your printer for a permanent hardcopy.

If you select some text and then decide against doing anything with it, you can choose the Cancel Text Selection 
command to deselect it.  Alternatively, you can just press your mouse button with the mouse cursor pointing somewhere in 
the terminal window to deselect text.
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Non-ASCII File Transfers

As we learned previously, a file transfer is nothing more than moving a computer program or data file from one disk to 
another.  You actually perform a file transfer when you drag an icon from one disk's window to another's under the Finder.  
For computer communications, file transfers are not quite as simple (and by no means as fast) as this, but they are nothing 
to be intimidated by.  The ability to get a copy of a file that's sitting thousands of miles away (or across the room on an unlike 
computer) is one of the biggest benefits of owning a modem.

Take this a bit slowly, re-reading as needed, and you'll be a master of this somewhat esoteric art in no time.
 
ASCII file transfers are nice because of their simplicity, but they also lack several necessary properties.  You can only 

send or receive ASCII information (the values 0 to 127), and there is no error-checking done to make sure that what one 
side sends is actually received without "garbage" characters from phone line noise being introduced.

 Red Ryder knows how to transfer files according to two different and commonly used non-ASCII protocols, or agreed 
upon sets of rules.  The first is called XMODEM and the second is called Kermit.

The first thing to know is that the other computer has to explicitly tell you that it offers either XMODEM or Kermit, and that 
you can't mix the two or you'll end up with two confused and frozen computers (you can abort a file transfer in progress by 
pressing your mouse button).

Both of these protocols rely on the remote machine to convey certain essential and expected information during the 
transfer in addition to the base data being transferred.  This information is error-checking data.  When one computer tells the 
other "Hey, there was garbage in that last block of data you sent", the other computer re-sends the information until both 
agree it arrived safely.

Kermit and XMODEM operate mostly alike as far as you're concerned. First, you'll tell the remote service to send or 
receive a certain file using either XMODEM or Kermit.  When the remote tells you it's ready to send or receive the file, you 
choose the appropriate Send File or Receive File choice from under the File menu.  If you're sending a file, you'll be 
presented with a file selection box that looks like this:
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  The files that can be transferred are displayed in the scrolling area.  The "Select" button is clicked when the desired file 
is highlighted.  After the file is selected, the file transfer begins automatically.  You can sit back and watch, as no interaction 
is required.

  If you intend to receive a file, you'll get a file definition box that looks like this:

Before you receive any file, it's a good idea to make sure you've got enough free space on your disk to hold the file.  You 
can check how much free space you have available by clicking on the Check Free Space button in the file definition box 
that comes up after choosing one of the file receive menu choices.  Click on this button repeatedly to look at the different 
mounted disk volumes.

In this box, you'll need to type in the name you want the file saved as.  Whether or not that name is actually used 
depends upon something called the "MacBinary" format.  Let's dive into this a bit deeper.

The Macintosh stores files on its diskettes in two different areas, called the data fork and resource fork.  When a file is 
received, the information must be placed in the correct location for the file to work properly as intended.  The problem is that 
the Macintosh data and resource forks are meaningful only to a Macintosh.  You'll probably be transferring files using many 
other kinds of computers (from IBM-PC's to DEC mainframes) as a go-between, and if we didn't massage the Mac file a bit, 
the Mac wouldn't know where to put data as the file is received, creating an inordinate mess.
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This problem was first solved by using a Mac program called BinHex.  BinHex codes a Mac file into a new format that 
can be sent over other computer models with no trouble.  When a file is then received on a Mac, the formatted file is again 
run through BinHex to restore it to its original form.  BinHex  worked well as a temporary thing, but it also had the 
disadvantage of requiring an extra step before the program could be sent or used, and files formatted with BinHex required 
extra disk space and transmission time.  You can recognize files that have been formatted with BinHex as they usually have 
the characters ".HEX", ".HCX", or ".HQX" at the end of their filenames.

A better solution has been recently proposed, called the "MacBinary Format".  This format kicks in automatically 
whenever you send or receive a non-TEXT type file.  A TEXT-type file, by the way, is equivalent to a file that has been saved 
under MacWrite using the "Text Only" option - doesn't contain any font, graphic, or formatting information.  Red Ryder knows 
by looking at the program as it is being sent or received whether or not the MacBinary Format should be used.  The 
MacBinary Format has only 128 characters of extra overhead, yet it carries a lot of information about the original file, such 
as its name, and creation and modification dates.

Programs using the MacBinary Format typically have the characters ".BIN" at the end of their filename when they are 
stored on non-Mac computers.  Again, you don't need to do anything special when downloading a MacBinary Format file 
(which is why it was created) - it's all taken care of for you.

Here's the rub with the name when you receive a file.  If it's a TEXT type file, the filename you typed into the file definition 
box will be used.  If it's a MacBinary Format file, Red Ryder will first try to use the program's original filename (not 
necessarily what you typed in).  If there's already a file by that name on your disk, it will go ahead and use the name you 
supplied in the file definition box.

XMODEM can be used only when your communications parameters are set to NO Parity, 8 Data Bits, and 1 Stop Bit.  
Kermit can use 7 or 8 Data Bits and any Parity setting with full MacBinary support.

If all of this sounds terribly difficult, don't despair!  Other Mac users will be happy to help out if you run into 
trouble, and after you've done it a time or two, XMODEM and Kermit will be a breeze.  Please ask the remote 
system's operator to direct you to any "Help" files for their system before attempting any file transfers.

The total number of errors during a transfer are displayed as the transfer progresses.  Unless you get a dialog box that 
tells you the transfer has failed, these errors have all been corrected.  During an Xmodem Binary Format transfer, Red 
Ryder will also display an "Estimated Minutes Left" value after about 20 blocks have been sent or received.  Take this only 
as an estimation - things such as errors or non-uniform timing can make this value somewhat inaccurate.  When less than a 
minute remains, this value is displayed as "<1".

Steps for XMODEM or Kermit File Transfer

1) Read "Help" files for the system you'll be using.  Contact the System Operator (SYSOP) if you have trouble finding the 
proper file transfer commands.
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2) Tell the remote service to send or receive the desired file.

3) After the remote service tells you it's ready to begin the transfer, select the proper file transfer command from under 
the File menu, specify the drive and the desired filename.

4) Watch 'er rip!  You can abort a transfer in progress by pressing your mouse button (the status bar area will invert 
graphically white on black when Red realizes you've pressed your mouse button).  Some remote systems won't abort 
properly when you do, so beware of this and be prepared to disconnect the phone manually.

Red Ryder has a dozen or so preferences for non-ASCII transfers to help you succeed in nearly any situation you might 
encounter.  Under the File menu, you'll see the Non-ASCII File Transfer Preferences command, which brings up a huge 
dialog box with the following options.

• Timeout after - XMODEM has some protocol rules regarding how long to wait before giving up and resending (or 
requesting a resend from the remote machine) when data does not appear for a stretch of time.  This is called the timeout 
period, and should normally be set from 3-5 seconds for most micro to micro transfers.  However, some large timesharing 
systems (like CompuServe and Delphi) introduce random and lengthy delays during peak traffic hours that would "bomb out" 
an XMODEM transfer that stuck to the timing rules.  Therefore, this option was provided to let you bend the rules a bit to be 
a bit more tolerant of those systems.  For Delphi or CompuServe, a recommended setting for this option is 10-20 seconds.

• Special Kermit ^Q handshake - some IBM mainframes that use an archaic communications front end require an 
additional handshaking process that this option provides.  The settings we have found to work for Kermit transfers with many 
IBM mainframes is this option set, using 8 data bits, MARK parity, 1 stopbit, and HALF duplex.  DO NOT set this option if 
you don't explicitly know that you need it, as the Kermit transfer may inexplicably lock up after the first packet of data is sent 
or received.

• Attempt CRC error checking for XMODEM receive - Red Ryder's XMODEM is capable of error-checking using two 
methods.  The oldest, most commonly used, and least intelligent way is called checksum.  The newest, less commonly 
used, but most intelligent is called CRC.  When sending a file XMODEM, Red Ryder responds to whatever the remote 
machine tells Red Ryder to use.  When receiving, Red Ryder first tries to use CRC error checking (if this option is set). If the 
remote machine does not respond, it then switches to the checksum method and the transfer should then progress.  If you 
know that the remote system does not support CRC checking, it would seem ridiculous to have to sit and wait for the CRC 
attempt to fail (which might take 15-30 seconds) before the transfer begins.  If you do not select this option, Red Ryder 
starts out by using the checksum method, which alleviates that delay.

• Recognize and convert received MacBinary format files - if you are going to be sending and receiving files that you 
know are not meant to be used on the Macintosh, you'll want to turn off this option.  Otherwise, leave it selected so that Red 
Ryder will automatically convert the file to its original usable form while it's being received.

• Send TEXT files using MacBinary format - TEXT files are normally sent just as they reside on the disk, without any 
MacBinary information supplied.  Unfortunately, you lose the file's original name (which may be important) as well as other 
things like its creator application and creation date.  This option sends the TEXT file with the MacBinary information, so that 
it is reconverted to its original form when received.  If you do choose to use this option, realize that the TEXT file can not be 
loaded into any other computer besides a Macintosh.
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• Received non-MacBinary format TEXT file creator - this option is equivalent to the "Received TEXT file creator" 
option under the ASCII File Transfer Preferences menu command.  If a file is in non-MacBinary format, this tells Red 
Ryder which creator application to assign to the TEXT file (that is, what Macintosh application will be started up when the 
TEXT file's icon is double-clicked).  The default is MACA, which is MacWrite.

• Strip linefeeds from received non-MacBinary format TEXT files - this is equivalent to the "Strip control characters 
from received files" option under the ASCII File Transfer Preferences menu command.  If it is selected, a file that is not in 
MacBinary format will have all linefeed characters removed before it is saved to disk.

• Auto-receive using volume/path - Since the majority of files you will be receiving will most likely be in MacBinary 
format, it seems a bit silly to keep providing filenames that will be trashed in favor of the file's original name.  If you select 
this option, whenever you select the Receive File - XMODEM or Receive File - Kermit menu commands, you do not get 
the  File Definition dialog box.  Instead, the transfer starts right up.

Here's how it works.  Red Ryder creates a file with a random file name (based on the Macintosh's system clock) that it 
saves the received data in.  If it's a MacBinary file, the original name is supplied during the transfer and is used at the end of 
the transfer to rename the file.  If the file is non-MacBinary or the MacBinary supplied name already exists, you will get a 
dialog box at the completion of the transfer telling you so, and you'll be asked to specify a new name for the file.

Remember that the File Definition box also let you tell Red Ryder where to save the file.  That's what the volume/path 
portion of this option is for.  You type a disk volume name (or HFS volume:folder path) into this box and that is where all files 
are saved.  The volume/path name should never end in a colon.  If you leave the box blank, the files are saved on the same 
volume as Red Ryder, which may or may not be desirable.

Immediately after you start up Red Ryder, it looks to see if the auto-receive option is enabled.  If it is selected, it then 
checks to see that the volume/path specified is mounted in one of the disk drives.  If it isn't you'll get a dialog box telling you 
so, and this option will be turned off. It also does this checking anytime you modify the volume/path information.  

There is one final feature to this option.  If this option is selected, Red Ryder jumps immediately into the XMODEM 
receive routine upon receipt of the control character sequence ESCAPE-b (ASCII code 27 followed by a lowercase 'b' 
character) or the Kermit receive routine after receipt of ESCAPE-k.  If for some reason you find yourself in the XMODEM or 
Kermit receive routines when you shouldn't be, suspect phone line garbage creating these characters as the cause and turn 
off this option for the remainder of that call.

• Before sending, instruct remote to auto-receive - this is the counterpart to the last paragraph.  Before sending a file 
XMODEM, if this option is selected an ESCAPE-b sequence is sent to the remote machine.  Before sending a file Kermit, an 
ESCAPE-k sequence is sent.  Note that if the remote machine is not using Red Ryder, or its "auto-receive" option is not 
selected, this option will have no affect on its operation.

• Enable CompuServe 'B' protocol (download only) - this feature was provided because there are certain times when 
XMODEM transfers on CompuServe are just not reliable.  For the record, I tested this version of Red Ryder by downloading 
Apple's Resource Editor program using XMODEM during a peak traffic period.  During the transfer (over 1000 blocks and 
149K of data), I forced more than 50 errors, each of which was corrected without the transfer breaking down.  My method of 
forcing errors is interesting.  I pick up the extension phone and do some primal scream therapy.  Very effective.
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Though I am confident in Red Ryder's XMODEM tolerance to networks like CompuServe, I would be naive to submit that 
it (or any program using XMODEM) could be 100% bulletproof.  CompuServe created a protocol that is an excellent 
alternative to XMODEM during busy times on the system.  It's called the 'B' protocol.  When this option is selected, Red 
Ryder will automatically kick into the 'B' protocol file receive mode when CompuServe tells it to.  You should disable this 
option when not communicating with CompuServe.

Notice there are no menu commands to start a 'B' protocol file transfer.  After you tell CompuServe to send the file using 
'B' protocol, it will then prompt you for the "Filename for your computer".  You should type in the disk volume name, a colon, 
and the filename you wish to save the program as on your Macintosh.  CompuServe then sends a control character 
sequence to Red Ryder telling it to start the transfer.  Red Ryder's 'B' protocol fully supports MacBinary files.

• SUPERCHARGED XMODEM receive - This option turns off the error correcting function of XMODEM receive, and tells 
the remote machine "I got that block of data correctly, send the next one." even before the complete block has been 
received.  For some bizarre reason, this has the effect on some networks (notably CompuServe and Delphi) of speeding up 
the transfer by an order of magnitude.  Here's the bad news:  since no error-correcting can be done, the entire transfer is 
cancelled the moment one error occurs, since a new block is on its way before Red Ryder can tell the host that the error 
occured and XMODEM can not "back up".

This is an option I fought to keep out of Red Ryder, because I felt it is a bastardization of the XMODEM protocol and 
castrates its primary usefulness. But as I said before, your demands outweigh mine.  However, I do make the following 
strong warnings.

Don't use this option on anything but short files and only then when you have a very clean telephone connection.  The 
time you spend to re-download a 50K program because an error occurred with only a couple of blocks to go is costly.  Don't 
use it with any network besides CompuServe or Delphi.

• Large progress indicator - the status bar area contains a small rectangle that is filled in during file sends or 
MacBinary format file receives as the transfer progresses.  Unfortunately, it's difficult to see this rectangle clearly from 
across the room.  If this option is selected, a very large circle is printed on the Mac display, and is filled in during the transfer 
in a pie-wedge manner.

During a file transfer, you are kept abreast of the various things that are happening.  However, some explanation is 
needed for the sequence of characters at the very left of the top line of the status display.  It may look something like:

*(BINARY)/CRC

If you have the SUPERCHARGED XMODEM option turned on, the asterisk is displayed first during an XMODEM 
receive, otherwise, the characters between the parentheses is displayed first.  These characters tell you what kind of file is 
being sent or received ("TEXT" for a non-MacBinary and "BINARY" for a MacBinary format file).  Finally if the CRC error 
checking method for XMODEM transfers is in use, the characters "/CRC" are displayed.


